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Preface 
Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology 

Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-085940.html 
contains the latest versions of the Agile PLM PDF files. You can view or download these manuals 
from the Web site, or you can ask your Agile administrator if there is an Agile PLM Documentation 
folder available on your network from which you can access the Agile PLM documentation (PDF) 
files. 

Note To read the PDF files, you must use the free Adobe Acrobat Reader version 9.0 or later. 
This program can be downloaded from the Adobe Web site http://www.adobe.com. 

The Oracle Technology Network (OTN) Web site 
http://www.oracle.com/technetwork/documentation/agile-085940.html can be accessed through Help 
> Manuals in both Agile Web Client and Agile Java Client. If you need additional assistance or 
information, please contact My Oracle Support (https://support.oracle.com) for assistance. 

Note Before calling Oracle Support about a problem with an Agile PLM manual, please have 
the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Readme 

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle 

Technology Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-
085940.html. 

Agile Training Aids 

Go to the Oracle University Web page 
http://www.oracle.com/education/chooser/selectcountry_new.html for more information on Agile 
Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.  

http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.adobe.com/
http://www.oracle.com/technetwork/documentation/agile-085940.html
https://support.oracle.com/
http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.oracle.com/education/chooser/selectcountry_new.html
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Chapter 1 

Introducing Agile Drive 

This chapter includes the following: 

 Working with Agile Drive ...................................................................................................................................... 1 
 Limitations ............................................................................................................................................................ 2 
 Definitions ............................................................................................................................................................ 2 
 Structure of Agile Drive ........................................................................................................................................ 3 
 What's New in Agile Drive 9.3.2 ........................................................................................................................... 4 

 

Agile Drive is a system of managing the file attachments of Agile objects from your computer 
system in the form of files and folders, without requiring you to invoke Agile PLM application. It 
connects Agile's Distributed File Manager as a network place on your system, thus enabling 
Explorer like operations, such as copy or delete, on file attachments of Agile objects. It simplifies file 
management, leveraging existing intuitive client applications, like Explorer, Mac Finder, etc. 

Working with Agile Drive 
Agile Drive enables you to use the files and folders available in Agile PLM without having to 
download them. With Agile Drive, you can carry out the following actions: 

1. Work on Files, such as documents, drawings, associated with Agile objects as file attachments 
in Agile PLM System 

 View a File: Open a file directly from an Agile Drive folder and view it in its native application, 
without downloading or checking out. 

 Save a File: Save a file directly in an Agile Drive folder and create a file attachment to the 
corresponding Agile object in the Agile PLM System.  

 Edit a File: Edit a file in its native application directly from an Agile Drive folder without 
downloading or checking out. To create a new version, save it as a new file. 

 Create a File: Create a new file in Agile Drive using drag and drop from a non-Agile Drive. 

 Delete a File: Delete a file from an Agile Drive folder using Delete key, which in turn deletes 
the file attachment from the corresponding Agile object in the Agile PLM system.  

 View File Properties: View file properties, such as data of creation, date of last modification, 
size and more. Right-click a file in the Agile folder to locate View File Properties.   

 Add a File: Add a file from your local drive, or any non-Agile network drive to an Agile Drive 
folder. Agile Drive stores this file as a file attachment to the corresponding Agile object in 
Agile PLM system. Agile Drive creates a version of every file that you add (this applicable 
only for Design and File Folder objects). You can choose either the Drag-Drop option or 
Copy-Paste option to add a file.  

 Move a File: Move a file from Agile Drive folder. You can use the Cut-Paste option to move a 
file from Agile Drive folder. Agile Drive creates a version of every file that you remove (this 
is applicable only for Design and File Folder objects). 

 Copy Files: Copy files from a non-Agile Drive folder into an Agile Drive folder or drag and 
drop the required file. 
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2. Work on Folders 

 View Folder Properties: Select Properties from right-click menu to view file properties of an 
Agile Drive folder. 

 

Limitations 
Agile Drive does not support the following functionalities: 

File Functions 

 Save a file to a folder on the Agile Drive. Use the Save As option to save the file under a 
different name.  

 Rename a file 

 Check-in files from Agile Drive folders 

 Check-out files into Agile Drive folders 

 Create files in Agile Drive folder 

 Extract data out of an uploaded file in Agile PLM 

 Undo operations 

Folder Functions 

 Create Agile Drive folders  

 Use the Copy-Paste option or the Drag-Drop option to move an Agile Drive folder into another 
Agile Drive folder 

 Use the Copy-Paste option or the Drag-Drop option to move a non-Agile Drive folder to an 
Agile Drive folder 

 Rename Agile Drive folders 

Business Functions 

 Affected Items & BOM revisions rendering only for ECOs 

 Design Structure expansion 

 Workflow approvals  

 Status change 

 Display of Application data (Cover Page/P2/P3) 

 PPM Content Tab 
 

Definitions 
Name Descript ions  

Agile Drive A file system that helps manage the files attached to objects in the Agile PLM system. It is 
a logical representation of the Agile PLM objects and their associated attachments. 

Agile object An entity defined in Agile PLM that groups a set of attributes and relationships related to 
that object. Examples: Item, Folder, etc.  
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Name Descript ions  

Agile PLM 
folder 

A folder in Agile PLM system that holds attachments of other Agile objects, such as Item, 
Change Order, etc. Agile PLM folder is also treated as an independent Agile object. 

Agile Drive 
folder 

A folder that represents an Agile object on your system.  

non-Agile 
Drive folder 

A folder on your system drive or any network drive other than Agile Drive. 

 
 

Structure of Agile Drive 
Agile Drive displays Agile objects as folders, and attachments as files in these folders. The table 
below gives us a better understanding of Agile objects in both; Agile Drive and Agile PLM system. 

Entity In Agile PLM System In Agile Drive 

Part  A Part is an Agile object.  

Example - P00003 

A Part is a folder, called as Agile Drive folder, 
named after the Agile object it represents. 
Example - P00003 

Revision A Revision is a state of an Agile 
object.  

Example: Introductory 

A Revision is a Sub-folder, again called as 
Agile Drive folder, named after the Revision 
state of the Agile object it represents. Example: 
Introductory 

Attachments An Attachment is a file associated to 
an Agile object.  

Example:  

- agile_20090224_075051312.axml 

- agile_20090224_113543937.axml 

- MirrorBolt1.SLDPRT 

An Attachment is a Agile Drive file contained in 
an Agile Drive folder. The name of this Agile 
Drive file is exactly the same as that of 
corresponding Attachment.  

Example:  

- agile_20090224_075051312.axml 

- agile_20090224_113543937.axml 

- MirrorBolt1.SLDPRT 

 

Agile Drive: An Agile Object and its File Attachments in Agile Drive  
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Agile PLM: An Agile Object and its File Attachments in Agile Application 

       

 

 
 

What's New in Agile Drive 9.3.2 
Agile Drive introduces the following updates in 9.3.2. 

 Configuring: 

 Agile Drive in the OAM Setup. Refer to Agile Drive Configuration for OAM Setup on page 7. 

 Cache Reload Interval and Timeout parameters. Refer to Parameter Definitions on page 6. 

 Mapping Agile Drive on Windows 7 System. Refer to On Windows 7 System on page 13. 

 Setting the Readonly property to 'FALSE' in the settings.conf file, turns on the read and write 
mode and allows you to modify files. Refer to Parameter Definitions on page 6. 
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Chapter 2 

Setting up the Agile Drive 

This chapter includes the following: 

 Enabling Agile Drive in Java Client ...................................................................................................................... 5 
 Configuring Agile Drive Settings .......................................................................................................................... 6 
 Mapping Agile Drive ............................................................................................................................................. 11 

 
 

Enabling Agile Drive in Java Client 
When you deploy Agile PLM, by default, the Agile Drive is set as Disabled. To use Agile Drive, 
ensure to enable it in Java Client. 

To enable Agile Drive: 

1. In Java Client, go to Server Settings > Preferences. 

2. From the Agile Drive dropdown list, select Enabled.  

Note By default, Agile Drive is set to Disabled. 

 

 

 

Once you enable the Agile Drive, the access will be Read-only. To change the access to Read-
Write, see Configuring the Agile Drive Settings. 

3. Restart all Distributed File Managers. 
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Configuring Agile Drive Settings 
You can customize settings for Agile Drive by editing parameter definitions in the settings.conf file. 

Changing Parameter Values in the settings.conf File 

To change parameter values in the settings.conf file: 

1. Navigate to Agile\agileDomain\applications\webdav.war\WEB-INF\classes\ 

2. Open ‘settings.conf’ file  

3. Set the readonly.mode=false & Save file. 

4. Restart FileServer. 
 

Parameter Definitions 

You can edit the settings.conf file to define the following parameters.  

 URL for Application and File Manager 

 User Account Details 

 Encoding Details 

 Readonly mode 

 Exclusion Filters 

 Cache tuning 

 Maximum rows displayed 
 

URL for Application and File Manager 

Name Descript ion  

app.server.url Specifies the location of the Agile PLM Application Server. The 
format is http://<Server>:<Port>/Agile/RMIServlet 

file.server.url Specifies the location of the File Server (Manager). The format is 
http://<Server>:<Port>/Filemgr/services/FileServer 

 

User Account Details 

User  Credent ia ls  Descript ion  

Name Agile User ID 
Example: ifsuser 

Password The encrypted Agile User Password   
Example: 221B758BAAE4C4 
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Encoding Details 

Parameter  Descript ion  

name.encoding Encodes directory names using HTML URL Encoding. 

Setting the value to ‘FALSE’ enables HTML 

URL encoding on folder names.  
 

Readonly mode 

Parameter  Descript ion  

readonly.mode Setting it to 'FALSE' turns on the ‘Read-write’ mode. Setting it to 
'TRUE' allows you to only view the files and not modify them. The 
default setting is 'TRUE'.  

 

Cache Tuning Parameters 

Parameter  Descript ion  

cache.reload.interval Setting it to 2 enables the user to refresh the cache twice. 

cache.timeout Setting it to 30 deletes inactive cache entries from the Agile Drive 
after 30 minutes. 

30 indicates the time to live (TTL) for cache entries. The minimum 
cache timeout is 20 minutes. 

 

Exclusion Filters 

Parameter  Descript ion  

exclude.filetypes Specifies file types that should be filtered out of the file list. Usage: 
exclude.filetypes - doc,dwg,prt. For example, to filter out Word files 
and show only PDFs, set exclude.filetypes=doc. 

 

Maximum rows displayed 

Parameter  Descript ion  

max.rows Specifies the number of rows to be displayed in the Search Results 
and BOM tables. 

Minimum value = 250.  

Maximum value = 5000 

 
 



 

 

8 Agile Product Lifecycle Management 

  

Agile Drive Configuration for OAM Setup 

The Agile Drive configurations given below are applicable for Oracle Access Manager and Windows 
NTLM. 

To configure Agile Drive for SSO setup: 

1. Ensure Agile Drive is enabled in the Java Client. 

 

 

2. Configure LDAP Authenticator in WLS Admin console. Refer to the Agile PLM Administrator 
Guide  for details on how to configure LDAP in WLS Admin Console. 
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3. Ensure the File Server and Agile Drive application are configured with WLS direct access 
without going through the proxy URL. 

Example:  

 IN server.conf for File server 

app.server.http://<Server>:<Port>/Agile/services/FSHelper 

file.server.url=http://<Server>:<Port>/Filemgr/services/FileServer 

dms.server.url=http://<Server:<Port>/Agile/services/DmsService 

 In Settings.conf for Agile Drive 

app.server.url=http://<server>:<Port>/Agile/RMIServlet 

file.server.url=http://<server>:<Port>/Filemgr/services/FileServer 
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4. Configure Agile drive in Windows XP and Window 7 and the results are as shown below. 

Windows XP 

   

 

Windows 7 

 
 

 

Deployment Architecture 

 XML based request/response model 

 Customized version of Tomcat 6.0 Web DAV Servlet 

 Supported on most platforms 

 Deployed on File Manager instance as a new Web Application 

 Communicates with Application Server for object meta data 

 Caching for better performance 
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Optional Settings 

Agile Searches on Windows XP/Vista times out after 30 seconds. This is due to the timeout feature 
of Microsoft Internet Explorer 7.  

To increase the Microsoft Client timeout:  

1. Add a ReceiveTimeout DWORD value with a data value of (<number of seconds>)*1000 in the 
Registry settings as follows: 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Internet Settings  
Example: If you want the timeout duration to be 8 minutes, set the ReceiveTimeout data value 
to 480000 (<480>*1000). 

2. Reboot the system. 
 

Platform Settings 
1. Microsoft Windows Explorer - XP/Vista 

The Web Folders Client is bundled in XP/Vista. Download and install Microsoft Web Folder 
Update KB907306 from  

http://www.microsoft.com/downloads/details.aspx?FamilyId=17C36612-632E-4C04-9382-
987622ED1D64&displaylang=en 

2. MAC OSX Finder 

To ensure the correct working of file uploads, disable the creation of intermediate file store 
(.DS_Store).  

http://support.apple.com/kb/HT1629  

3. IIS Support 

Supports only IIS 6.0 & 7.0. 

Ensure that the WebDAV Web Service Extension is set to Allowed. 

 

Mapping Agile Drive 
You can map Agile Drive on one of the following operating systems. 

 On Windows XP System on page 12 

 On Windows Vista System on page 12 

 On Windows 7 System on page 13 

 On Macintosh System on page 15 

 On GNOME Linux System on page 15 

 On KDE Linux System on page 17 
 

http://www.microsoft.com/downloads/details.aspx?FamilyId=17C36612-632E-4C04-9382-987622ED1D64&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=17C36612-632E-4C04-9382-987622ED1D64&displaylang=en
http://support.apple.com/kb/HT1629
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On Windows XP System 

To map Agile Drive on MS Windows XP system: 

Note You cannot deploy Agile Drive on MS Windows XP-64 since it does not contain the web 
folders component. 

1. On the desktop, double-click the My Network Places icon. 

 

2. Click the Add a network place link. 

3. In the Add Network Place Wizard window click Next. Choose a network location. 

4. Enter the Host Name or IP Address of the server where Agile Drive is deployed, together with its 
Port Number and the Folder Name, as follows: 

http://<Host Name or IP Address>:<port>/webdav/ 

Note Use the host name/IP address of web proxy or Tomcat server where Agile drive is  
deployed (same as the Agile File Manager by default). 

Note Contact your Agile administrator for the IP Address and complete path of Agile 
Drive. 

5. Click Next. In the Connection window that pops up, enter your Agile PLM username and 
password. 

Note Contact your Agile administrator for username and password. 

If you do not want Agile Drive to ask you for user name and password each time you connect, 
select the Remember my password check box. 

6. Click OK. Enter a name for the network place.  

7. Click Next. 

8. Click Finish. 

The Agile Drive folder window appears. 

 

On Windows VISTA System 

To map Agile Drive on Windows VISTA system: 

1. Click Computer in the Start menu. 

In the Computer window, click the Map a Network Drive icon. 

In the Map Network Drive wizard window, click the Connect to a Web site that you can use to store your 
documents and pictures link. 

In the Add Network Location Wizard window, click Next. Choose a custom network location. 

2. Specify the location of your website. 

3. Select Choose a custom network location. 

4. Enter the Host Name or IP Address of server where Agile Drive is deployed, together with its Port 
Number and the Folder Name, as follows: 
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http://<Host Name or IP Address>:<port>/webdav/ 

Note Use host name/IP address of web proxy or Tomcat server where Agile Drive is 
deployed (same as Agile File Manager by default). 

Note Contact your Agile administrator for the IP Address and complete path of Agile 
Drive. 

5. Click Next. 

6. In the Connection window that pops up, enter your Agile PLM username and password. 

Note Contact your Agile administrator for username and password.  

If you do not want the Agile Drive to ask you for username and password each time you wish to 
connect, select the Remember my password check box.  

7. Click OK. Enter a name for the network location. You may change this name to one of your 
choice.  

8. Click Next.  

9. Click Finish.  

The Agile Drive folders window appears. 

Important Agile Drive folders do not open in Windows VISTA on double-clicking. Right-click on it 
and select Open. 

 

 

On Windows 7 System 

To map Agile Drive on Windows 7 system (both 32-bit and 64-bit machine): 

1. Click the Start button in Windows 7. 

2. Run regedit. 

  

       

3. Navigate to key 
“HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\WebClient\Parameters” in 
regedit and modify the parameter “BasicAuthLevel” with value of 2. This enables basic 
authentication for Windows 7. 
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4. Close regedit to save the changes. 

5. Restart the service of “WebClient” in Windows 7 Services. 
 

 

6. Launch the command in Windows 7. 

7. Enter the following in the command line: net use * http://<Host Name or IP 
Address>:<port>//webdav/ PASSWORD /USER:USERID where User= Username, and 
password. 

8. Press ENTER. 
  

 

You have successfully mapped Agile Drive on Windows 7. 
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Users connecting to Agile Drive on WIN7 face the following warning. 

       

Since this is a WIN7 limitation, the workaround is to disconnect and configure Agile Drive again. 

 

On Macintosh System 

To map Agile Drive on the Macintosh system: 

1. Select Connect to Server from Go in Main menu. 

2. In the Connect to Server window, enter the Host Name or IP Address of the server where Agile Drive 
is deployed, together with Port Number and Folder Name, as follows: 

http://<Host Name or IP Address>:<port>/webdav/ 

Note Use host name/IP address of web proxy or Tomcat server where Agile Drive is 
deployed (same as Agile File Manager by default). 

Note Contact your Agile PLM administrator for required data values. 

3. Click Connect. 

4. Enter your Agile PLM username and password. 

5. Click OK.  

The Agile Drive folder window appears. 

 

On GNOME Linux System 

To map Agile Drive on the GNOME Linux system: 

1. Select Connect to Server... from Places in the Main menu. 

//Dscdac02.agile.agilesoft.com/swap_directory/Usha/ForScott/F_17257
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The Connect to Server screen appears. 
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2. Enter the following parameters: 

Service type Select WebDAV (HTTP) from the drop-down list. 

Server Enter the IP Address of the server where Agile Drive is deployed.  

Port Enter Port Number of the server. The default value is 80.  

Folder Enter webdav in lower case.  

User Name Enter your Agile PLM username. 

Name to use for connection Enter any name of your choice.  

 

Note Contact the Agile administrator for required values.  

3. Click Connect.  

4. Enter your Agile PLM password and click Connect.  

The Agile Drive default folder window appears. 

On KDE Linux System 

To map Agile Drive on the KDE Linux system: 

1. Open Shell Console and execute knetattach.  

 

 

2. Select Webfolder (webdav) and click Next.  

3. Enter the following data: 

Name Enter a name of your choice.  

User Enter your Agile PLM user name. 

Server Enter the IP Address of the server where Agile Drive is 
deployed.  

Port Enter Port Number of the server. The default value is 80.  

Folder Enter webdav in lower case.  

 

Note Contact the Agile administrator for required values.  

4. Click Connect.  

The Agile Drive folder window appears. 
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Chapter 3 

Using the Agile Drive 

This chapter includes the following: 

 Searching for Agile Objects ................................................................................................................................. 19 
 Working with Files and Folders ............................................................................................................................ 20 
 Opening files in Agile Drive .................................................................................................................................. 22 
 Tracking Versions ................................................................................................................................................ 22 
 Traversing Item Revisions ................................................................................................................................... 25 
 Traversing a Bill of Material ................................................................................................................................. 26 

 

You can access Agile Drive using Windows Explorer, listed under My Network Places. When 
prompted, log in using your Agile PLM user name and password.  

For quick access to Agile Drive, you may create a shortcut on your desktop or create its menu item 
in the Start Menu.  

Note MS Vista 64-bit and Windows XP 64-bit are not supported because Microsoft does not 
ship the required drivers. To open a folder, right-click on it and select Open. 

Note Access to Agile Drive folders and files depends on the roles and privileges assigned to 
you in Agile PLM Administrator. 

 

Searching for Agile Objects 
You can search for Agile PLM objects using Agile's canned (predefined) queries, such as Global 
Searches and Personal Searches. A canned search query appears as a folder in Agile Drive, and 
the Search Results appear as folders within this folder. 

For example, to perform a search called Unreleased Changes That I Created, navigate to the 
corresponding Folder. All unreleased changes that you created appear as folders within this Search 
folder. Navigate to the desired unreleased change folder to see the affected items and its 
attachments, if any. 
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Search Limitations 

Any search that requires user inputs or search criteria is not a feature of Agile Drive. For example, 
you cannot search for a specific ECO, say ECO25000. To search for specific searches, you need to 
use the Explorer feature of file or folders search. 

To search for specific folders in (Windows XP): 

1. Click Start > Search > For Files or Folders... 

2. In the Search Results window, click All Files and Folders. Specify the search criteria in the search 
field(s). 

3. In the Look in drop-down list, select Browse.. A Browse for Folder window pops up. 

4. Expand My Network Places and select the Agile Drive. 

5. Click OK to return to the Search Results window. 

6. Click Search button.  

The specified object appears as a folder in the Search results. 
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Working with Files and Folders 
You can perform the following actions on files and folders in Agile Drive. 

Note Due to limitations of the client OS, Agile Drive error messages do not show up correctly 
on the client side. 

Caution Intermittent failures can occur while adding multiple files on MAC OSX Finder. 

 

How to  Steps  

View or read 
 a file 

In an Agile Drive folder, double-click a file to read or view. Alternately, select Open from 
the right-click menu. The system opens the file in its associated application. 

For example, when you double-click a MS Word document file in an Agile folder, the 
system invokes MS Word, which opens this document in editable mode. If MS Word is 
not installed on your system, you cannot view the document. 

You can only open the MS Office files directly from Agile Drive provided MS Office or MS 
Office Viewer application is installed on your system. For every other file type, you need 
to drag and drop  the file (or copy the file and paste it) to the desktop or local drive and 
open it with its associated application. 

Save a file In Agile Drive, you can save a file in two ways: 

Save a new file in an Agile Drive folder directly: Create a file in an application and 
click Save (or Ctrl+S). In the Save window, select and save it in the desired Agile Drive 
folder. 

Save As: After editing an existing file in the Agile Drive folder, you can only save it using 
the Save As option due to the versioning aspect of Agile PLM. 

Use the Save As function to copy a file from an Agile Drive folder to your system folder, 
and save it after editing.  

Delete a file Deletion of a file from an Agile Drive folder implies removal of a file attachment from an 
Agile object.  

To delete a file, select the desired file(s) in the Agile Drive folder and press Delete (Del) 
key once, or select Delete from right-click menu.  

The system deletes the file(s) without issuing any warning or requesting any confirmation. 
Agile Drive continues to display the deleted file(s) until you Refresh the display.  

Although the file appears to be deleted from Agile Drive folder, and from the 
corresponding Agile object, the Agile PLM application does not purge it out.  

Agile Drive does not allow deletion of a Redlined File. 

View 
properties of 
a file 

Select Properties from right-click menu of a selected file in the Agile Drive folder, to view 
its general properties. 

Add a file Adding a file in an Agile Drive folder implies adding a file attachment to an Agile object. 
You can do this by  

- copying & pasting  

- dragging & dropping, a file from a non-Agile Drive folder into an Agile Drive folder.  
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How to  Steps  

You can also use the Save, and Save As features to save a file from an application. 

Agile Drive does not display the added file(s) until you refresh the display.   

When you add multiple files in Read-only mode of Agile Drive, a pop-up message 
appears for each file you add. It is recommended that you add only one or two files at a 
time. 

Copy a file 
from an Agile 
Drive folder 
to a non-Agile 
Drive folder 

In an Agile Drive folder, select the desired file.  

Select Copy from the right-click menu, or select Copy from Edit Menu of MS Windows 
Explorer. 

Navigate to the desired non-Agile Drive folder. Select Paste from the right-click menu, or, 
select Paste from Edit Menu of MS Windows Explorer. 

View folder 
properties 

To view general properties of a folder in Agile Drive, select Properties from right-click 
menu. 

 
 

Opening files in Agile Drive 
Agile Drive supports opening only Microsoft Office format files from the Internet Explorer. 

To open files in Agile Drive: 

 For HTML, DOC, RTF, XLS, PPT and other Microsoft formats which support Microsoft clients: 
Double-click the file or open within Internet Explorer after authentication. 

Note Text and PDF files do not open in Agile Drive. 

To open text and PDF files: 

1. Select the files from the Agile Drive folder. 

2. Drag and drop the files to the desktop.  

3. Click Open. 

To open files in Adobe Reader or Notepad:  

1. Select the file from the Agile Drive folder. 

2. Click File > Open. 

3. Navigate to Network Places > Agile Drive. 

4. Click Open. 
 

Tracking Versions 
Versioning applies to Design objects and File Folder objects of Agile PLM. When you add or delete 
a file attachment from a Design object or a File Folder object, Agile PLM retains the original status 
of these attachments as a version.  

Agile Drive displays these versions as numbered folders under Previous Versions Folder in the 
'versioned' Agile object, with Version Number 1 being the oldest/earliest version of the said Agile 
object. 
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This can best be understood with the example below: 

1. In Agile Drive, select FOLDER00947, as shown in Screen 1. It contains three files.  

FOLDER00947 in Agile Drive is an Agile PLM File Folder Object, which has three file 
attachments. 

Screen 1: Select a folder in Agile Drive 

       

 

2. Add a file in FOLDER00947. The folder now contains four files. 

       Screen 2: Add a file 

       

 

3. Wait for a few seconds and refresh (press Ctrl+F5) the Explorer view.  

A Previous Versions folder, and a sub-folder numbered 1, appears under FOLDER00947. This 
implies FOLDER00947 is the 'latest' version of File Folder object, which now has four file 
attachments. 

Screen 3: Previous Versions Folder 

       

 

4. Go to the folder 1 under Previous Versions folder.  

It contains the three files that originally existed in FOLDER00947 before you added the fourth 
file. This implies, the 'earlier' version of the File Folder object had three file attachments. 
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Screen 4: Earlier/older Version Folder - '1' 

     

 

5. Now, go back to FOLDER00947, which is the 'latest' version. Delete one of the files, say 
Bike2.bmp. This folder now has three files. 

This implies, you have deleted a file attachment from the File Folder object. 

Screen 5: Delete a File 

    

 

6. Wait for a few seconds and refresh (press Ctrl+F5) the Explorer view.  

The Previous Versions folder now has two sub-folders numbered 1 and 2.  This implies, the Agile 
Drive folder number 2 is the 'previous' version of the said File Folder object, FOLDER00947, 
and it has the four file attachments that existed before you deleted one. 

Screen 6: Previous Version 

    

 

Likewise, each time you add or delete any file in an Agile Drive folder (corresponding to a Design 
object or File Folder object), it maintains the original files in version numbered folders under the 
Previous Versions folder.  

Note You cannot add or delete files from any of the Previous Version folders. 

If you delete, or purge, a version folder in Agile, the deleted or purged version folder does not 
appear in the corresponding Agile Drive folder. The number of version folders that you see depends 
on the settings in Agile PLM.  
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Note Refreshing (Ctrl+F5) the view in MS Windows XP Explorer does not display the changed 
versions in the folders (left) pane, although the changed versions appear in the right 
pane. 

 

Traversing Item Revisions 
A revision in Agile Drive appears as a 'prefix' to the Change object. The structure of Agile Drive 
folder, thus, appears as follows: 

<Revision Name> - <Change Object Name> 

Example: In the image below, the Agile Drive folder B - ECO-00075 corresponds to Revision B of 
Change Object ECO-00075 associated to Agile object P00058. 

 

      

 

The Agile objects, whose revisions are not yet defined in Agile are represented as  

<UNDEFINED> - <Change Object Name> 

Example: In the above image, since the new Change object, ECO-00077 has not been assigned a 
Revision Number, it is in the Pending state and hence appears as (UNDEFINED) - ECO-00077 in Agile 
Drive. 

When you create a Part, its revision state is Introductory. When you bring about a change to this 
Part, a Revision is created, which is identified by a Revision Number. Once the Revision Number is 
assigned, it remains in the pending state until released. The pending state is represented by 
enclosing the revision number in brackets.  

Example: In this image, (C) - ECO-00076. 

Other than the latest released revision, Agile Drive moves the 'earlier released revisions' into an 
Agile Drive folder called Other Revisions. Every time an Agile object goes through a Change, the 
latest revision appears as an Agile Drive folder under the folder for the main object. 

Example: In the above image, the Agile Object P00058 had undergone a change by means of Change 
object ECO-00064, which was revised only once as Rev-A. Later, it went through another change, 
ECO-00075, which was revised to Rev-B.  

Note Agile Drive does not display the structure of Design objects. 
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Traversing a Bill of Material 
The Bill of Material (BOM) of an Agile object appears as folders under its corresponding Change 
object. 

In a BOM, the file attachments of a Parent object are located in the Change object. For example, 
the file attachments of Part P00058 are located under the folder B - ECO-00075, which corresponds to 
the Change object of this Part. 

The file attachments of a Child object are located in its corresponding folder. For example, 100-
01014-A is the child object of P00058. 

     

 


